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PREFACE 
 
 
For geotechnical in-situ investigation the cone penetration test has been used world-wide. Based on 
the results of this type of soil investigation insight in the build-up and the bearing capacity of the 
subsoil will be gathered. 
Usually the output of the cone penetration test is available in a digital form according to a customer 
specific format. This seems to be an ideal situation, as each customer gets this output in the format he 
asked for. However, the result is that there is still a number of formats, which are hard to be 
interchanged thus being a hindering for a sustainable storage of these data. Moreover, due to the 
variation in formats there is a continuous need for different conversion programmes for the use of 
these digital cone penetration data in the design of structures. 
Besides the mentioned disadvantages, this variation in formats leads to waste of time, money and 
energy. For a start in the Netherlands these costs amount to at least NLG 600.000 or Euro ≈ 270.000  
a year (price level 1999). 
 
This situation has induced the development of a standard format. 
The first step in this process was an inquiry among a large number of users in order to determine the 
content of the standard format. The next step was a research into the available international formats. 
Comparison of this research with the results of the inquiry leads to the choice of one existing format as 
a basis to derive the new standard. Besides the new standard format a number of tools are developed, 
a/o. verification software and a viewer. By now several Dutch companies and organisations are using 
this standard format. In the mean time a number of computer applications is making use of this new 
standard format. 
 
At the time of compiling of this manual, the research committee “Standardisation digital CPT-results” 
comprised: 
 
F.J.J.A. van Dam, chairman Ministry of Transport, Public Works and Water Management, 

Directorate-General for Public Works and Water Management, Civil 
Engineering Division 

W.A. Nohl, secretary Fugro Ingenieursbureau 
Dr. H. den Adel GeoDelft 
P. van Asten A.P. v.d. Berg  
C.N. Bremmer Netherlands Institute of Applied Geoscience TNO 
F.P.H. Engering GeoDelft 
S.K. Jonker Ministry of Transport, Public Works and Water Management, 

Directorate-General for Public Works and Water Management, Road 
and Hydraulic Engineering Division 

A.G.M. Knibbeler MOS Geotechnics 
W.J. van Niekerk Ballast Nedam Engineering 
A. Jonker, coordinator CUR 
Prof. J.K. Vrijling, mentor CUR 
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Besides these members of the research committee a number of corresponding members were involved:  
 
W.M. Bielefeld IJsselmeer Beton 
L. Buth The Netherlands Standardisation Institute 
M.G. van Dierendonck Adviesbureau Tjaden 
P.G. van Duijnen Holland Railconsult 
M.G.A. van den Elzen T & E Consult 
P. van Goudoever VOTB 
H.J.M. Lamers Ascal 
F.W.M. Mol Ministry of Transport, Public Works and Water Management, 

Directorate-General for Public Works and Water Management, Civil 
Engineering Division 

K. Peppelman Technosoft 
I.L. Ritsema Netherlands Institute of Applied Geoscience TNO 
E.J.C. Wassenaar GeoMil Equipment 
 
The finances for developing the standard format were provided by  
- Ministry of Transport, Public Works and Water Management, Directorate-General for Public 

Works and Water Management, Civil Engineering Division 
- NS Rail Infrastructure 
- Ballast Nedam Engineering 
- Public Works Rotterdam   
- Fugro Ingenieursbureau  
- GeoDelft 
- MOS Geotechnics 
- NITG TNO 
- DHV Environment and Infrastructure 
- Haskoning 
- LWI – Land Water Environment Information Technology 
- CUR – Centre for Civil Engineering Research and Codes 
  
The software and this report are available free at www.geonet.nl/ gef, with the possibility to make a 
download. 
The CUR-organisation guarantees that the format will be maintained; if there are any questions or tips, 
please inform us.  
Infodesk: Fred Jonker, ' +31 182 54 06 30  
 
June 1999                  The Board of the CUR  
November 2000 
September 2002 
April 2004 
September 2006 

 

http://www.geonet.nl/
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1 INTRODUCTION 
 
A new exchange format for digital cone penetration test data 
Cone penetration tests are extensively used in soil mechanics to determine the layer structure and the  
bearing capacity of the subsoil. Data from the cone penetration test is stored digitally and supplied to 
the client in the format they request. The result is a large variety of formats which makes mutual 
exchange problematic and hinders durable storage of penetration test data. The standard format in 
accordance with GEF-CPT-Report brings an end to this confusing situation.  
 
Why a new format? 
Existing formats are specifically directed at a client and are therefore not unambiguous and  
exchangeable. In cases where there are large quantities of penetration test data delivered in a variety of 
formats, this not only leads to communication problems but also delays and increased costs. 
 
New format in accordance with GEF-CPT-Report 
 
Uniform: 
Conversions belong to the past; the format offers completeness, as the structure stores all relevant 
information. 
 
Flexible: 
In addition to certain minimal information, the user can add specific data. 
 
Unambiguous: 
Storage of the measurement data is unambiguous. In the case of measured  pore water pressure, for 
instance, the level at which this is measured  is also stated (in the cone or at a higher level). It is also 
possible to include more than one pore water pressure measurement. 
 
Directly applicable: 
‘Links” with the GEF-CPT-Report were made for various companies during the development traject. 
This means that there is already application software which can use penetration test data directly from 
the GEF-CPT-Report. A “link” is also supplied to convert GEF-CPT-Report files into NENGEO 
format (and conversely). Furthermore, the direct applicability is enhanced by the availability of an 
“Excel-link” for importing and processing penetration test data as required. 
 
Freely available tools: 
The format is provided with freely available tools for verifying the supplied data and for making 
“links”. The verification software checks whether the structure of the data file complies with that of 
the GEF-CPT-Report ( not a contents verification of the data file, but a check whether the structure 
satisfies  GEF-CPT-Report). For verification purposes, a simple viewer is also provided. 
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Usefulness 
The continuous development traject, involving a large number of experts, has resulted in high quality 
and efficiency. It will be possible to use the new format efficiently, particularly on large projects 
involving many parties. 
 
GEF and GEF-CPT-Report 
- GEF (Geotechnical Exchange Format) is a general language structure for storing and transferring 

geotechnical information. GEF states in a procedural way how a new structure (a set of rules for 
the storage of measurements) should be composed. This report provides a basis for a general 
exchange of digital cone penetration test data.  

- GEF-CPT-Report is the specific structure for reporting cone penetration test data. 
 
GEF Verification is a stand-alone application which can be used to verify if files comply with the new 
GEF-CPT-Report Format. Verification consists of checking for syntax errors and contextual 
inconsistencies in digital CPT-files using the GEF-CPT-Report Format. The software opens a GEF-
file and performs a verification. A log of the errors that are found is given. Batch verification of GEF-
files is also possible. In the case of the verification of a single file, the file itself as well as a graph, 
displaying the most important data, viz. cone resistance, sleeve friction, friction ratio and pore water 
pressure, can be displayed. 
 
GEF Verification 1.0 was developed by NITG-TNO for LWI and released in September 1998. 
 
GeoDelft and NITG-TNO have assembled a library which can be used to create conversion programs 
between other formats and GEF. This library was named GEFLIB. 
 
A conversion tool named GEF-NENGEO/NENGEO-GEF Conversion was developed to convert 
between the CPT-file format NENGEO and the GEF-CPT-Report format. 
 
This document will describe the following: 
 
1. The GEF language 
2. The format for reporting CPT results 
3. The GEF verification tool 
4. The GEF library 
5. The GEF-NENGEO/NENGEO-GEF conversion tool 
 
(Nov 2000 N) Since its introduction in June 1999 a wide range of experience has been gained in 
working with the Geotechnical Exchange Format for the Cone Penetration Test. Users have provided 
feedback which allowed us to improve the appliability of GEF-CPT-Report, provide additional 
explanation on some features and fix bugs. The results of the working experience is added to the 
original report. In the text supplementory information or corrections can be recognized by (Month 
Year C), like at the start of this paragraph. A C signals a correction, a N is a new feature, I is 
informative or illustrative.  
 
(2006 Sept N) The latest version is GEF-CPT-Report, 1, 1, 2, gefcr112.pdf 
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2 FORMAT OF A GEF-CPT-REPORT FILE 
 
In accordance with GEF, the file contents is divided into two main components: the header and the 
data block. The header contains the following information: 
 
- summary of the original information sources (file tracing) 
- description of the cone penetration data (data descriptive) 
- description of the subsequent measurement and calculation procedures (procedure descriptive) 
- structure information about the file (file descriptive). 
 
The data block is a table containing the measured data and the calculated information. 
 

2.1 Header 
 
A complete list of the items which can be used and which may appear in the GEF-CPT-report header 
is given below. A default value is given for several items. If this default value is applicable, the item 
can be omitted. 
 
Items printed in bold text in the following sections are always to be included in a GEF-CPT-report 
file, while the other items are optional. 
 

2.1.1 File tracing 
 
- Name of executing company 
- Order number 
- Date when GEF-CPT-Report file is created 
- Identification number of the cone penetration test 
- Employee, responsible for the data 
 

2.1.2 Data descriptive 
 
- Data format (this must be ASCII for a GEF-CPT-Report) 
- Number of columns in the data block 
- Number of lines in the data block 
- Column information = description for each column 
- Definition of “invalid measurement value” for each column. 
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2.1.3 Procedure descriptive 
 
Project information 
- Project name 
- Client name 
- Name of location. 
 
Apparatus and procedures 
- Type and serial number of the penetration cone 
- Nominal surface area of the cone tip in mm2  
- Nominal surface area of the friction casing in mm2 

- Net surface quotient of cone tip and friction casing 
- Distance between cone and centre of friction casing in mm 
- Location of the PPT filter (u1, u2 or u3) 
- Type of cone penetration test (Cone, possibly supplemented with Friction, PPT and/or inclination) 
- Use of back-flow compensator (yes/no) 
- Reference to standard (NEN 5140 or 3680) 
- Class of penetration test in accordance with NEN 5140. 
 
Location of penetration test 
- Coordinate system used 
- X and Y coordinates of the penetration test location 
- Reference level (Z coordinate) 
- Height of the selected fixed horizontal surface (= usually ground level) with respect to the 

reference level 
- Description of pre-drilled/pre-excavated soil 
- Groundwater level 
- Unusual circumstances. 
 
Measuring 
- Date the penetration test was carried out 
- Time when penetration test began 
- Depth of first observation with respect to the selected fixed horizontal surface (for pre-testing, 

excavation or -drilling) 
- Final depth of penetration test 
- Stop criteria 
- Zero values of all measurement elements before and after penetration test 
- Minimal and maximum values per column. 
 
Comments 
- Mass and geometry of the probe apparatus, including anchoring 
- Method for processing interruptions 
- Correction method for zero drift 
- Remarks. 
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2.1.3.1 Analysis 
 
- Calculation formula for calculated columns or references to the standard or a publication where 

this method of calculation is described 
 
Reporting 
- Printing format for the columns in the data block 
 

2.1.4 File descriptive 
 
- GEF version number 
- GEF-CPT-Report Procedure Code 
- Type of computer system. 
 
(Nov 2000 N)  
- GEF version number 
- Code for reporting the data: 

• either Procedurecode for GEF-CPT-Report  
• or       Reportcode for GEF-CPT-Report  

- Type of computer system. 
 
(April 2004 N) More specificly:  
• For files of version 1,0,0, the keyword Procedurecode is the mandatory codeword, describing the 

file type and version:  
#PROCUDURECODE = GEF-CPT-Report,1,0,0, reference document 

• For file, version 1,1,0 and up, the file description must either be stated in Reportcode or in 
Procedurecode. Reportcode is the preferred keyword: 
#REPORTCODE = GEF-CPT-Report, 1, 1, 0, reference document 

 
This means that when reading GEF-files and when the keyword Reportcode is not found in a file, the 
contents of keyword Procedurecode –if present- is used. When both keywords are missing, the file 
type can not be determined and the file can not be recognized or processed as a file conform GEF-
CPT-Report. In the rare case both Reportcode and Procedurecode are encountered, Procedurecode is 
ignored for the determination of the type of file. Reportcode prevails. So we encourage, when writing 
new GEF-files, only to use Reportcode. 
 
In short: 
Version 1,0,0 Version 1,1,0 and up 
#PROCUDURECODE = GEF-CPT-
Report,1,0,0, reference document 

#REPORTCODE = GEF-CPT-Report,1,1,0, reference 
document 

 Depreciated: 
#PROCUDURECODE = GEF-CPT-Report,1,0,0, reference document 

 

2.2 Data block 
 
The data block is composed of a variable number of columns, of which two columns are reserved for 
the two compulsory measurement values: the penetration length and the cone resistance. The other 
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columns are available for the remaining direct measurement values and the derived results. A number 
of quantities are defined in Section 3.4. 
 
A text field can be appended as the last column in the data block to add comments on a specific 
measurement scan, for example reference to a dissipation test. 
(Nov 2000 I) Additionally these text fields require the GEF code words columntext, recordseparator, 
and columnseparator. 
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3 CPT REPORT FILE IN GEF FORMAT 
 

3.1 Code words used in the CPT Report 
 
The starting point of the CPT Report file is that the measurement variables and text which it sets out 
have a fixed position. In accordance with the GEF definition, there is room for 1500 measurement 
variables and texts, where the first 128 variables and texts within the GEF-CPT-Report definition are 
reserved for (future) “fixed” data (see Sections 3.2 and 3.3). Users can extend the list by using further 
free variables and texts (numbers 129 up to and including 1500). 
 
The exact definition of the code words is defined in “GEF, release 1.0.0” (see appendix 2).  
 
Four types of variables are given in the list below, indicated between []: 
 
(Nov 2000 I) 
- Character a single readable symbol 
- Text readable text with a maximum of 256 characters, without commas, backslashes, equals 

signs or hashes (, \ = #) 
- Number an integer number 
- Figure a floating point number. 

 
Items printed in bold text in the list below must always be present in a CPT Report file, while the 
other items are optional. The italic text provides brief information about the relevant code word. 
 
#GEFID = 1,0,0 releasenumber GEF  
(Nov 2000 N) or depending on the use of the Child or Parent code word 
#GEFID = 1,1,0 release number GEF  
#COLUMN = [number]  the number of columns in the data block 
#COLUMNINFO = [number], [text], [text], [number] column number, dimension, 

quantity, quantity number. See table in section 3.4  
#COLUMNINFO = 1, m, penetration length, 1  
#COLUMNINFO = 2, MPa, Cone value, 2 
#COLUMNMINMAX = 1, [figure], [figure] 
#COLUMNMINMAX = 2, [figure], [figure] 
#COLUMNMINMAX = 3, …, … etc. 
#COLUMNSEPARATOR = [character]  text dividing columns (default = space) 
#COLUMNTEXT = [number], [text] text on or off  

0 = off 
1 = on 

#COLUMNVOID = 1, [figure]  definition of "no value" 
#COLUMNVOID = 2, [figure] 
#COLUMNVOID = 3, ... etc. 
#COMPANYID = [text], [text], [integer]  executing company 
#DATAFORMAT = ASCII (this is the compulsory data format) 
#FILEDATE = [number], [number], [number]  yyyy, mm, dd 
#FILEOWNER = [text]  
#LASTSCAN = [number] number of measurement scans in data block 
#MEASUREMENTTEXT = 1, [text], client  
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#MEASUREMENTTEXT = 2, [text], project name 
#MEASUREMENTTEXT = 3, [text], name of location 
#MEASUREMENTTEXT = 4, [text], cone type and serial number 
#MEASUREMENTTEXT = 5, [text], Mass and geometry of probe apparatus\, incl. anchoring 
#MEASUREMENTTEXT = 6, [text], according to standard NEN 5140 incl. Class\, NEN 

3680,…. 
#MEASUREMENTTEXT = 7, [text], own coordinate system 
#MEASUREMENTTEXT = 8, [text], own reference level 
(Nov 2000 N) 
#MEASUREMENTTEXT = 9, [text], fixed horizontal level (= usually ground level) 
#MEASUREMENTTEXT = 10, [text], orientation of biaxial inclination measurement (N-

direction) 
#MEASUREMENTTEXT = 11, [text],unusual circumstances 
#MEASUREMENTTEXT = 20, [text], correction method for zero drift 
#MEASUREMENTTEXT = 21, [text], processing method for interruptions 
#MEASUREMENTTEXT = 22, [text], remarks 
#MEASUREMENTTEXT = 23, [text], remarks 
#MEASUREMENTTEXT = 30, [text], calculation formula for column … 
#MEASUREMENTTEXT = 31, [text], calculation formula for column … 
(Sept 2006 N)  
#MEASUREMENTTEXT = 41, [text], railway or dike code 
#MEASUREMENTTEXT = 42, [text], method for the determination of the ZID 
#MEASUREMENTTEXT = 43, [text], method for the determination of the XYID  
#MEASUREMENTTEXT = 44, [text], Orientation X axis inclination 
#MEASUREMENTVAR = 1, [figure], mm2, Nom. surface area of cone tip  
#MEASUREMENTVAR = 2, [figure], mm2, Nom. surface area of friction casing  
#MEASUREMENTVAR = 3, [figure], -, Net surface area quotient of cone tip  
#MEASUREMENTVAR = 4, [figure], -, Net surface area quotient of friction casing 
#MEASUREMENTVAR = 5, [figure], mm, cone distance to centre of friction casing  
#MEASUREMENTVAR = 6, [number], -, friction present 
#MEASUREMENTVAR = 7, [number], -, PPT u1 present 
#MEASUREMENTVAR = 8, [number], -, PPT u2 present 
#MEASUREMENTVAR = 9, [number], -, PPT u3 present 
#MEASUREMENTVAR = 10, [number], -, inclination measurement present 
#MEASUREMENTVAR = 11, [number], -, use of back-flow compensator 
#MEASUREMENTVAR = 12, [number], -, type of penetration test 
#MEASUREMENTVAR = 13, [figure], m, pre-excavated depth 
#MEASUREMENTVAR = 14, [figure], m, groundwater level 
#MEASUREMENTVAR = 15, [figure], m, water depth (for offshore activities works)  
#MEASUREMENTVAR = 16, [figure], m, end depth of penetration test 
#MEASUREMENTVAR = 17, [number], -, Stop criteria  
#MEASUREMENTVAR = 20, [figure], MPa, zero measurement of cone before penetration 

test 
#MEASUREMENTVAR = 21, [figure], MPa, zero measurement of cone after penetration 

test 
#MEASUREMENTVAR = 22, [figure], MPa, zero measurement friction before penetration 

test 
#MEASUREMENTVAR = 23, [figure], MPa, zero measurement friction after penetration 

test 
#MEASUREMENTVAR = 24, [figure], MPa, zero measurement PPT u1 before penetr. test 
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#MEASUREMENTVAR = 25, [figure], MPa, zero measurement PPT u1 after penetr. test 
#MEASUREMENTVAR = 26, [figure], MPa, zero measurement PPT u2 before penetr. test 
#MEASUREMENTVAR = 27, [figure], MPa, zero measurement PPT u2 after penetr. test 
#MEASUREMENTVAR = 28, [figure], MPa, zero measurement PPT u3 before penetr. test 
#MEASUREMENTVAR = 29, [figure], MPa, zero measurement PPT u3 after penetr. test 
#MEASUREMENTVAR = 30, [figure], degrees, zero measurement inclination before 

penetr. test 
#MEASUREMENTVAR = 31, [figure], degrees, zero measurement inclination after penetr. 

test 
#MEASUREMENTVAR = 32, [figure], degrees, zero measurement inclination NS before 

penetr. test 
#MEASUREMENTVAR = 33, [figure], degrees, zero measurement inclination NS after 

penetr. test 
#MEASUREMENTVAR = 34, [figure], degrees, zero measurement inclination EW before 

penetr. test 
#MEASUREMENTVAR = 35, [figure], degrees, zero measurement inclination EW after 

penetr. test 
(Sept 2006 N)  
#MEASUREMENTVAR = 41, [figure], km, location in ‘line coordinate’ 
#MEASUREMENTVAR = 42, [figure], degrees, angle between positive X and North 
 
(April 2004 N) See section 2.1.4 
Version 1, 0, 0 
#PROCEDURECODE = GEF-CPT-Report, 1,0,0 release of CPT-Report  
Version 1, 1, 0 
(Nov 2000 C) or (see remarks before section 3.2) (Nov 2000 N) 
#REPORTCODE = GEF-CPT-Report, 1,1,0, - release of CPT-Report 
#PROCEDURECODE = GEF-CPT-Report, 1,1,0, - release of CPT-Report 

• Reportcode is preferred.  
• It is either Reportcode of Procedurecode, not both 

Version 1,1,1 
(Sept 2002 N) or (see section 3.3, Table 3.1 and Table 3.2) 
#REPORTCODE = GEF-CPT-Report, 1,1,1, - release of CPT-Report 

• Reportcode is preferred.  
• It is either Reportcode of Procedurecode, not both 

#PROJECTID = [text], [text], [text]  order number 
#RECORDSEPARATOR = [character] symbol at end of a measurement scan (default = 

CR/LF)  
#REPORTDATAFORMAT = [character] print format per column, according to FORTRAN-

definition 
  Iw = Integer, w positions long 

Fw.d = Floating pointing number, w positions long with d 
decimal positions 
Ew.d = Idem, but with exponent  

#SPECIMENVAR = 1, [figure], m, [text], depth in m –mv and sample code 
according to NEN 5104 of the pre-drilled soil 

#SPECIMENVAR = n , [figure], m, [text], depth in m –mv and sample code 
according to NEN 5104 of the pre-drilled soil  

#STARTDATE = [number], [number], [number] yyyy, mm, dd 
#STARTTIME = [number], [number], [number] hh, mm, ss.s 
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(Nov 2000 C) 
#TESTID = [text]  identifying number of penetration test 
#XYID = [number], [figure], [figure] , [figure] , [figure]  

coordinate system, X, Y, delta X, delta Y 
The coordinate systems are linked to a country code so that the 
first numbers 0000-0009 are defined free or international. 
00000 = own coordinate system see #MEASUREMENTTEXT = 7 
00001 = Geographic Coordinate System 
01000 = SPCS 
31000 = RD: coordinate system = Cartesian, date= RD1918,  
projection method = stereographic 
31001 = UTM-3N: coordinate system = Cartesian, date = 
ED50, projection method = Mercator, central meridian = 3°OL 
31002 = UTM-9N: coordinate system = Cartesian, date = 
ED50, projection method = Mercator, central meridian = 9°OL 
32000 = Belgian Bessel: coordinate system = geographic,  
date = BD72, projection method = Belgian Lambert 
49000  = Gauss-Krüger: coordinate system = Cartesian, date = 
Potsdam, projection method = Transversal Mercator 

(Nov 2000 N) 
#ZID = [number], [figure] , [figure]  height system, Z, delta Z 

The height systems are linked to a country code. 000-0009 are 
defined free or international 
00000 = own reference level see #MEASUREMENTTEXT = 8 
00001 = Low Low Water Spring 
31000 = NAP 
32000 = Ostend Level 
(Nov 2000 C) 

  32001 = TAW 
49000 = Normal Null 

#EOH  = 
 
In order to facilitate self-description of the code words, two special code words have been defined: 
#STRUCTURETEXT = [code word], [text], [text], … semantic definition of the code 

word 
#STRUCTURETYPE = [code word], [text], [text], .… syntactic definition of the code 

word. 
 
(Nov 2000 I) Remarks. 
- The code word Procedurecode is conceived for referring to the quality system of the engineering 

company that performed the CPT. Their quality manual will provide detailed information of the 
entire process of the methods for measurement, analysis, filing and reporting a cone penetration 
test.  

• If information is available about the process of measuring, analysing, filing an reporting a test, 
Procedurecode should refer to this information.  

• If information about measuring, analysing and filing is absent and if the data being reported 
comply the rules as stated in this document, Procedurecode should read: GEF-CPT-Report  

- The code word Reportcode is conceived for providing information about the process of reporting 
data. E.g. if it reads “GEF-CPT-Report , 1, 1, 0”, the reader knows that the report is in accordance 
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with the rules of CUR’s definition for the exchange of results of cone penetration tests, as 
described in the November 2000 edition of this document. 

- The figures Release, Version and Update provide information about the specific definition of the 
report. If a report complies to all required items as indicated in this text by (Nov 2000 N), its 
version figure should read 1. If it uses only a few of these new items, the report is still complying 
the rules of the original version of June 1999, being a 1,0,0 report.  

- In order to be able to recognise a file as being a GEF-CPT-Report file, the following rules are 
followed: 
(April 2004 N) 
Version 1,0,0 
#PROCEDURECODE = GEF-CPT-Report, 1, 0, 0 
Version 1,1,0 and up 
#REPORTCODE = GEF-CPT-Report, 1, 1, 0 (preferred) 
The use of #procedurecode = GEF-CPT-Report, 1, 1, 0 is depreciated, however still allowed.  

 

3.2 Reserved MEASUREMENTVAR’s 
 
The list in section 3.1 assigns a number of MEASUREMENTVAR variables. In a GEF-CPT-Report 
these variables can only be used for the allotted quantities. The table below provides an overview of 
the numbers reserved for MEASUREMENTVARs. 
 
 
Sequential 
number 

[Default] value Unit Quantity 

1 [1000] mm2 nom. surface area cone tip 
2 (Nov 2000 C) [15000] mm2 nom. surface area friction sleeve 
3  - net surface area quotient of cone tip 
4  - net surface area quotient of friction sleeve 
5 [100] mm distance of cone to centre of friction sleeve 
6 0= no 

1= yes 
- friction present 

7 0= no 
1= yes 

- PPT u1 present 

8 0= no 
1= yes 

- PPT u2 present 

9 0= no 
1= yes 

- PPT u3 present 

10 0= no 
1= yes 

- inclination measurement present 

11 0= no 
1= yes 

- use of back-flow compensator 

12 0= electronic penetration test 
1= mechanical discontinue 
2= mechanical continue 

- type of cone penetration test 

13  m pre-excavated depth 
14  m groundwater level (Nov 2000 N) with respect to 

the datum of the height system in ZID 
15  m water depth (for offshore activities) 
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Sequential 
number 

[Default] value Unit Quantity 

16  m end depth of penetration test  
17 0= end depth reached 

1= max. penetration force 
2= cone value 
3= max. friction value 
4= max. PPT value 
5= max. inclination value 
6= obstacle 
7= danger of buckling 

- stop criteria 

18-19   for future use 
20  MPa zero measurement cone before penetration test 
21  MPa zero measurement cone after penetration test 
22  MPa zero measurement friction before penetration test 
23  MPa zero measurement friction after penetration test 
24  MPa zero measurement PPT u1 before penetration test 
25  MPa zero measurement PPT u1 after penetration test 
26  MPa zero measurement PPT u2 before penetration test 
27  MPa zero measurement PPT u2 after penetration test 
28  MPa zero measurement PPT u3 before penetration test 
29  MPa zero measurement PPT u3 after penetration test 
30  degrees zero measurement inclination before penetration 

test 
31  degrees zero measurement inclination after penetration 

test 
32  degrees zero measurement inclination NS before 

penetration test 
33  degrees zero measurement inclination NS after penetration 

test 
34  degrees zero measurement inclination EW before 

penetration test 
35  degrees zero measurement inclination EW after 

penetration test 
36-40   for future use 
41  km mileage 
42  degrees Orientation between X axis inclination and North. 

See section 3.7 Sept 2006 N 
 
(Nov 2000 N). The reference level in measurementvars 14 (the elevation of the ground water level) is 
the datum of the height system as used in the code word ZID.  
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3.3 Reserved MEASUREMENTTEXT’s 
 
The list in section 3.1 assigns a number of MEASUREMENTTEXT variables. These texts can only be 
used in a GEF-CPT-Report for the allotted quantities. The table below provides an overview of the 
numbers reserved for MEASUREMENTTEXT. 
 
 
Sequential 
number 

Quantity 

1 client 
2 name of the project 
3 name of the location 
4 cone type and serial number 
5 Mass and geometry of probe apparatus, including anchoring 
6 applied standard, including class 
7 own coordinate system 
8 own reference level 
9 fixed horizontal level (usually: ground level or flow bed) 
10 orientation direction biaxial inclination measurement (N-direction) 
11 unusual circumstances 
12-19 for future use 
20 correction method for zero drift 
21 method for processing interruptions 
22 remarks 
23 remarks 
24-29 for future use 
30 calculation formula or reference for column number… 
31 calculation formula or reference for column number… 
32 calculation formula or reference for column number… 
33 calculation formula or reference for column number… 
34 calculation formula or reference for column number… 
35 calculation formula or reference for column number… 
36-40 for future use 
41 highway, railway or dike code 
42 method for the determination of the ZID, see Table 3.1; Sept 2002 N 
43 method for the determination of the XYID, see Table 3.2; Sept 2002 N 
44 Orientation of the X axis of the inclination measurement (optional), see 

section 3.7. Sept 2006 N 
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(Sept 2002 N) 
The accuracy of the values listed in XYID and ZID depends on the method of determination of the X, 
Y and Z coordinates. The method can be listed in measurementtexts 42 and 43. Note that the use of 
these measurementtexts are only standardised from GEF-CPT-Report release 1, version 1 and update 1 
on. In GEF-CPT-Report 1,0,0 and 1,1,0 measurementtexts 42 and 43 have no meaning.  
 
Abreviation Method 
MMET Measured, surveying 
MDGP Measured, differential GPS 
MGOV Measured, other methods 
MH10 Estimated, contour map 1:10.000 
MT25 Estimated, Topographic map 1:25.000 
MT50 Estimated, Topographic map 1:50.000 
MAHN Estimated, 'Actueel Hoogtebestand Nederland' 
MSOV Estimated, other methods 
MONB Estimated, unknown method 
MFIC Fictive value 

Table 3.1 Methods for the determination of the height of fixed horizontal level of the CPT, as 
reported in ZID. Code for measurementtext 42. 

 
Abreviation Method 
LMET Measured, surveying 
LGPS Measured, GPS 
LDGM Measured, diff. GPS, > 5 m 
LDGN Measured, diff. GPS, between 1 and 5 m 
LDGZ Measured, diff. GPS, < 1m 
LGOV Measured, other methods 
LT10 Estimated, Topographic map 1:10.000 
LT25 Estimated, Topographic map 1:25.000 
LT50 Estimated, Topographic map 1:50.000 
LD01 Estimated, detailed map 1:100 
LD02 Estimated, detailed map 1:200 
LD05 Estimated, detailed map 1:500 
LD10 Estimated, detailed map 1:1000 
LD25 Estimated, detailed map 1:2500 
LSOV Estimated, other methods 
LONB Estimated, method unknown 

Table 3.2 Methods for the determination of the position of the CPT: XYID. Code for 
measurementtext 43. 
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3.4 Definition of columns in the data block 
 
The following table lists 20 quantities numbers. Each number is unequivocally linked to a physical 
quantity: the number identifies which physical quantity is listed in a specific column.  
 
Measurement value or calculated value Unit Quantity number 
penetration length m 1 
measure cone resistance qc MPa 2 
friction resistance MPa 3 
friction number % 4 
pore pressure u1 MPa 5 
pore pressure u2 MPa 6 
pore pressure u3 MPa 7 
inclination (resultant) degrees 8 
inclination N-S degrees 9 
inclination E-W degrees 10 
corrected depth, measured below the fixed m 11 
horizontal surface   
time s 12 
corrected cone resistance qt MPa 13 
net cone resistance qn MPa 14 
pore ratio Bq - 15 
cone resistance number Nm  16 
weight per unit volume, γ kN/m3 17 
in-situ, initial pore pressure uo MPa 18 
total vertical soil pressure, 0vσ  MPa 19 

effective vertical soil pressure, 0vσ ′  MPa 20 

Inclination in X direction degrees 21  (Sept 2006 N) See 3.7 
Inclination in Y direction degrees 22  (Sept 2006 N) See 3.7 
Electric conductivity S/m 23  (Sept 2006 N)  
Reserved for future use  24-30 
Bx (magnetic field strength in X direction) nT 31  (Sept 2006 N) See 3.8 
By (magnetic field strength in Y direction) nT 32  (Sept 2006 N) 
Bz (magnetic field strength in Z direction) nT 33  (Sept 2006 N) 
Btot (total magnetic field strength) nT 34  (Sept 2006 N) 
Magnetic inclination degrees 35  (Sept 2006 N) 
Magnetic declination degrees 36  (Sept 2006 N) 
 
 
It should be noted that the penetration length ( = the uncorrected depth of the cone below the fixed 
horizontal surface) is the first quantity in the data block.  
 
(Nov 2000 N) In GEF-CPT-Report 1,0,0 the directly measured values of all quantities are values taken 
at the same time as the cone resistance is observed. From GEF-CPT-Report 1,1,0 on, data in a scan 
refer to the values which are measured at the same penetration length as the cone resistance is 
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observed. When time, characterized by quantity number 11, is reported, its value in a particular scan 
relates to the penetration length of the cone tip.  
 
(Nov 2000 I) Sections 3.5 and 3.6 are added. 

3.5 Length, depth and elevation 
These three quantities must be used with care. The standard in civil engineering is being followed, see 
Figure 3.1 
 

Figure 3.1 The relation between length, depth and elevation 
 
- Elevation is measured with respect to a datum: e.g. a national standard. If the vertical position of 

a point is higher than the datum, its elevation is positive, if the position of a point is lower than 
the datum, its elevation is negative.  

- Length is the distance along a path. A distance is always a positive quantity. The penetration 
length of the cone is therefore positive. 

- Depth is the length of the projection of a path on a vertical line, so it is a positive quantity.  
- "Depth with respect to a datum" is synonymous with elevation.  
 
Since in Figure 3.1 the path of the cone is inclined, its penetration length is larger than its depth. Both 
quantities are positive. The tip of the cone is beneath the datum, so the elevation of the tip of the cone 
is negative. It may lead to confusion that in common day practice, especially in spoken language, the 
theoretical difference between depth and elevation has vanished. Depth is being used when "depth 
with respect to a datum" (elevation) is meant.  
 

3.5.1 Penetration length 
Penetration length is a length. A length is a quantity with a positive value, therefore the penetration 
length, as listed in the column with quantity number 1, must be positive. The verification program for 
GEF-CPT-Report will report an error in a GEF-CPT-Report 1,1,0 file, when the penetration length is 
negative. Depth, characterized by quantity number 11, is the projection of the path of the cone tip on a 
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vertical line. It is corrected for the inclination of the penetration path. Therefore GEF-CPT-Report 
1,1,0 requires that the column, characterized by quantity number 11, contains positive numbers. 
 

3.6 Reference level 
 
In GEF-CPT-Report 1, 0, 0 the level of referencing the penetration length is not a mandatory item. 
This may lead to a non-unique interpretation of the actual location of the measured cone resistance. 
Therefore the CUR committee E15 has decided to provide for means which allow for a unique 
interpretation regarding depth, by adding Measurementtext number 9 and ZID to the list of mandatory 
items.  
 

Figure 3.2 National reference level, fixed horizontal level and penetration length 
 
Measurementtext number 9 provides information about the elevation of the horizontal reference level 
for a CPT. Although the user is free to define his of her own reference level, e.g. the base of the 
foundation of an existing building, the CUR committee E15 strongly advises to select either 
groundlevel or the sea or the river bed as the fixed horizontal level. This level usually coincides with 
the level at which a CPT is being started. Additionally to the mandatory appearance of 
measurementtext number 9 in GEF-CPT-Report, the code word ZID is declared compulsory as well. 
ZID must provide information about the elevation of the reference level, which is recorded in 
Measurementtext number 9. ZID enables the calculation of the elevation of each reading, with respect 
to a datum, a national reference point.  
 
In order to simplify the use of the standard and the interpretation of the readings, three examples are 
given. For reasons of clarity only a part of the header and data block is displayed. The absolute 
reference level is chosen to be either NAP, which is the national reference level in the Netherlands, 
which is indicated by type ‘31000’ in ZID or Low Low Water Spring. The principle as explained in 
these examples is not restricted to these particular height systems, each national standard will do.  
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3.6.1 Example 1 
In this example the fixed horizontal reference level coincides with ground level. Ground level will be 
the starting point for the cone penetration test. The first reading will be at ground level, penetration 
length is 0.0. Ground level is found to be 5 m higher than the datum: zero level of NAP (≡31000). 
Furthermore the inclination of the cone is constant: 20°. 
 

Figure 3.3 Selection of the fixed reference level: groundlevel 
 
#MEASUREMENTTEXT = 9, ground level, fixed horizontal reference level 
#ZID = 31000, 5.0 
 
penetration length 

 
[m] 

depth 
 

[m] 

elevation with 
respect to NAP 

[m] 
0.00 0.0 5.00 
0.02 0.019 4.981 
0.04 0.038 4.962 
0.06 0.056 4.944 
0.08 0.075 4.925 
0.10 0.093 4.907 
etc etc etc 

5.30 4.98 +0.02 
5.32 4.999 +0.001 
5.34 5.018 -0.018 
5.36 5.037 -0.037 
etc. etc etc. 

 

Table 3.3 Relative and absolute location of the readings 
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The calculation of the location of the code tip with respect to a national reference level is performed 
by: 
 

depth - in ZID Value  level reference national of datum respect toith location w =  (3.1) 
 
Note that in equation (3.1) depth is meant in its pure definition: the projection of the penetration length 
on a vertical line.  
 

3.6.2 Example 2 
In this example a layer of soil, 1.8 m tick, had to be removed due to the presence of rubble. This is 
indicated in the GEF file by Measurementtext 13: pre-excavated depth. Since this is a depth, its value 
is positive. To signal an invalid cone resistance a columnvoid for column number 2 (cone resistance) 
is –100 [MPa]. The horizontal reference level is ground level, which is 3 m below the absolute 
reference level (NAP≡31000). The cone has a constant inclination of 20° with respect to a vertical 
line. 
 
#COLUMNVOID = 2, -100.0 
#MEASUREMENTTEXT = 9, ground level, fixed horizontal reference level 
#MEASUREMENTVAR= 13, 1.8, m, pre-excavated depth 
#ZID = 31000, -3.0 
 

Figure 3.4 Pre-excavation 
 
Penetration length is the length with respect to the fixed horizontal reference level. When a layer of 
1.8 m of soil is removed, no values of the penetration length between 0 and 1.8 m are available. A 
cone resistance in air or water makes no sense. There are two possibilities to list the data. The first one 
is to remove all readings from the data file which refer to penetration lengths within the layer of 
removed soil: between 0 and 1.8 m of depth. The first scan has a penetration length of 1.8 m. The 
second method reports the values which refer to penetration lengths within the removed layer by their 
Columnvoid value. Both methods are listed in Table 3.4. Any other method is not in agreement with 
GEF-CPT-Report. Verification software will report deviations from the GEF-CPT-Report standard.  
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 Method 2 

  pen. length 
[m] 

cone resist. 
[MPa] 

depth 
[m] 

elevation 
[m] 

  0.00 -100 0 -3.00 
Method 1 0.02 -100 0.019 -3.019 

etc etc etc etc pen. length 
[m] 

cone resist. 
[MPa] 1.78 -100 1.673 -4.673 

1.80 0.5 1.80 0.5 1.691 -4.691 
1.82 0.5 1.82 0.5 1.710 -4.710 
1.84 0.5 1.84 0.5 1.729 -4.729 
1.86 0.5 1.86 0.5 1.748 -4.748 
1.88 0.5 1.88 0.5 1.767 -4.767 
etc etc etc etc etc etc 

Table 3.4 Penetrationlength, depth and elevation of the readings with pre-excavation  

 
According to our expectations there is no difference in the location with respect to NAP, as visualised 
by both methods. So the report will either start at a penetration length of 1.80 m, which value has to be 
the same as listed in measurementvar 13, or has to list columnvoid at least up to a penetration length 
equal to the value as listed in measurementvar 13. In the CUR committee E15 exists a slight 
preference for method 1, since it seems more natural than method 2.  
 

3.6.3 Example 3 
A similar situation occurs when a cone penetration test is performed at sea. In such cases CUR 
committee E15 strongly advises to select the sea bed as the fixed horizontal reference, to be reported 
in measurementtext 9. The value of ZID reports the elevation of the sea bed with respect to Low Low 
water Sping (=00001). The elevation of the sea bed is –40 m. For educational reasons the path of the 
cone is chosen to be inclined by 20°, see Figure 3.5. 

Figure 3.5 The fixed horizontal level is the sea bed.  
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Due to the rather soft nature of the sea bed it it always difficult to distiguish the difference between 
water and sea bed. Therefore an initial penetration will occur. The initial penetration contributes to the 
uncertainty in the elevation of the tip of the cone. Since the sea bed is far below the reference level, the 
elevation of the cone tip is negative. 
 
(Sept 2006 N) Sections 3.7 and 3.8 are added. 

3.7 Direction of inclination measurement 
In a GEF-CPT-Report file the inclination of the cone can be presented in two perpendicular directions. 
The CUR committee E12 has chosen these directions as North-South and East-West. In practical 
situations sometimes the directions are indicated with respect to a local coordinate system, which is a 
coordinate system relative to the compass rose. This is optional. The CUR committee strongly 
recommends to use the North-South and East-West direction.  
 
These directions with respect to a local coordinate system can be represented as an X and Y direction. 
In order to relate the directions of the inclinations with respect to the compass, the direction of the X 
axis with respect to the compass must be known. Note that the penetration length, corrected for 
inclination, is calculated by means of the resultant inclination, which is a vectorial sum of the 
inclinations in both directions. The actual directions of the individual inclinations no longer matters in 
the resultant inclination, so the resultant inclination does not depend on the choice of reference system.  
 
If the perpendicular inclinations are measured with respect to a local coordinate system, the quantity 
numbers of these inclinations should be: 21 for the X direction and 22 for the Y direction.  
 
The inclination is defined in the keywords COLUMNINFO: 
 
#COLUMNINFO = 5, degrees, Inclination X, 21 
#COLUMNINFO = 6, degrees, Inclination Y, 22 
 
The X and Y axis usually correspond to a local coordinate system, e.g. the X axis is parallel to a 
sheetpile wall or a road. When the inclination is given in X and Y direction, a description of the 
orientation of the X axis should –this is an obligation- be presented as a text in measurementtext 44. 
For example, when the X axis is parallel to a sheetpile wall: 
 
#MEASUREMENTTEXT = 44, The X direction is parallel to the sheetpile wall, 
Orientation X axis 
 
Optionally the direction of the XY coordinate system can be presented in the file. The direction is 
defined as the angle between North and the positive X direction. Its value is stored in measurementvar 
42. For example, when the angle between the positive X axis and North is 37 degrees: 
 
#MEASUREMENTVAR = 42, 37, degrees, angle between positive X and North 
 
In this example the positive X direction lies between North North East and North East.  
 
Which North? Since the magnetic North is constantly changing and since the angle between magnetic 
North and celestial North -the latter indicated by the polar star- is a function of the location on earth,. 
North means the celestial North. This is the same as North on a (high quality) map.  
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3.8 Magnetic field 
Some cones are equiped with a sensor which is sensitive to magnetic fields. In this way the local 
magnetic field of the earth can be measured.  
 
Remarks.  

1. This quantity is optional.  
2. The total magnetic field of the earth is currently approximately 0.5 Gauss. That is 50000 nT. 

1 nT is the same as 1 gamma.  
3. The magnetic inclination is at the earth’ equator approximately 0 degrees, near the magnetic 

poles about 90 degrees.  
4. Btot, inclination and declination are a representation in polar coordinates of the cartesian Bx, 

By and Bz.  
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4 EXAMPLES OF PENETRATION TESTS IN GEF-CPT-REPORT FORMAT 
 

4.1 The minimum report of a cone penetration test in GEF-CPT-Report 
 
#GEFID = 1,0,0  
(Nov 2000 C) 
#PROCEDURECODE = GEF-CPT-Report, 1,1,0, - 
#COMPANYID = CPT bv, Sondeerburg, 31 
#PROJECTID = CT, 380730 
#FILEDATE = 1998,02,18 
#TESTID = C2-265 
#FILEOWNER = W.A. van Buuren 
#COLUMN = 2 
#LASTSCAN = 1251 
#COLUMNINFO = 1, m, penetration length, 1 
#COLUMNINFO = 2, MPa, Cone, 2 
(Nov 2000 N)  
#MEASUREMENTTEXT = 9, ground level, horizontal reference level 
(Nov 2000 N) 
#ZID = 31000, -2.41 
#EOH  = 
(Nov 2000 N) 
0.12   0.205 
0.14   0.199  
0.16   0.219 
0.18   0.252 
0.20   0.298 
0.22   0.338 
0.24   0.437 
….. 
….. 
24.80   21.828 
24.82   22.057 
24.84   21.929 
24.86   21.433 
24.88   19.936 
24.90   18.599 
24.92   17.926 
24.94   18.004 
24.96   18.567 
24.98   19.387 
25.00   19.64 
25.02   19.747 
25.04   20.261 
25.06   21.368 
25.08   23.121 
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4.2 Extensive cone penetration test in GEF-CPT-Report format 
 
#GEFID = 1,0,0  
#COLUMN = 11 
#COLUMNINFO = 1, m, penetration length, 1 
#COLUMNINFO = 2, MPa, Cone value, 2 
#COLUMNINFO = 3, MPa, Friction, 3 
#COLUMNINFO = 4, MPa, Pore pressure u2, 6 
#COLUMNINFO = 5, degrees, Inclination NS, 9 
#COLUMNINFO = 6, degrees, Inclination EW, 10 
#COLUMNINFO = 7, m, corrected depth, 11 
#COLUMNINFO = 8, MPa, corrected cone value, 12 
#COLUMNINFO = 9, %, friction number, 4 
#COLUMNINFO = 10, s, time, 12 
#COLUMNINFO = 11, MPa, excess pore pressure, 15 
(Nov 2000 N) 
#COLUMNMINMAX = 1, 1.52, 57.68 
#COLUMNMINMAX = 2, 0.33, 61.12 
#COLUMNMINMAX = 3, 0.000, 1.324 
#COLUMNMINMAX = 4, -0.064, 2.060 
#COLUMNMINMAX = 5, 0.02, 9.25 
#COLUMNMINMAX = 6, .04, 8.41 
(Nov 2000 N) 
#COLUMNMINMAX = 7, 1.52, 57.52 
#COLUMNMINMAX = 8, -0.522, 60.892 
#COLUMNMINMAX = 9, -0.164, 119.189 
#COLUMNMINMAX = 10, 1, 3995 
#COLUMNMINMAX = 11, -0.557, 1.511 
#COLUMNSEPARATOR = : 
#COLUMNTEXT = 1, on 
#COLUMNVOID = 1, -99999 
#COLUMNVOID = 2, -99999 
#COLUMNVOID = 3, -99999 
#COLUMNVOID = 4, -99999 
#COLUMNVOID = 5, -99999 
#COLUMNVOID = 6, -99999 
#COLUMNVOID = 7, -99999 
#COLUMNVOID = 8, -99999 
#COLUMNVOID = 9, -99999 
#COLUMNVOID = 10, -99999 
#COLUMNVOID = 11, -99999 
#COMPANYID = CPT bv, Sondeerburg, 31 
#DATAFORMAT = ASCII 
#FILEDATE = 1998, 02, 29 
#FILEOWNER = W.A. van Buuren 
#LASTSCAN = 2808 
#MEASUREMENTTEXT = 1, NS, client 
#MEASUREMENTTEXT = 2, HSL-line, project name 
#MEASUREMENTTEXT = 3, Franeker, name of location 
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#MEASUREMENTTEXT = 4, C5W1-007, cone type and serial number 
(Nov 2000 C) 
#MEASUREMENTTEXT = 5, Ballast wagon 18; 25 tons: no anchoring, equipment 
#MEASUREMENTTEXT = 6, NEN 5140 class 1, applied standard 
(Nov 2000 C)  In this example measurementstexts 7 and 8 are removed, since they confuse the user. 
#MEASUREMENTTEXT = 9, ground level, fixed horizontal .level 
#MEASUREMENTTEXT = 10, lighthouses, N-direction inclinometer 
#MEASUREMENTTEXT = 11, Torrential rain, Unusual circumstances 
#MEASUREMENTTEXT = 20, Zero drift of the cone elements remains within the norm 

therefore no correction, Correction method 
#MEASUREMENTTEXT = 21, No special processing used, method of processing 

interruptions 
#MEASUREMENTTEXT = 22, At 12.25 m a thin gravel layer, remarks 
(Nov 2000 C) 
#MEASUREMENTTEXT = 30, The corrected cone value is corrected according to “Soil 

Characterisation by In Situ Tests” 1998-01-05 sect 2.16., 
calculation 

(Nov 2000 C) 
#MEASUREMENTTEXT = 31, Excess pore pressure dU = U – U0 where U0 is the 

groundwater level at that place, calculation 
#MEASUREMENTVAR = 1, 1000, mm2, Nom. surface area cone tip 
(Nov 2000 C) 
#MEASUREMENTVAR = 2, 15000, mm2, Nom. surface area friction element 
#MEASUREMENTVAR = 3, 0.62, -, Net surface area quotient of the cone tip 
#MEASUREMENTVAR = 4, 1.0, -, Net surface area quotient of the friction casing 
(Nov 2000 C) 
#MEASUREMENTVAR = 5, 100, mm, distance between cone and centre of friction casing 
#MEASUREMENTVAR = 6, 1, -, Friction present 
#MEASUREMENTVAR = 7, 0, -, PPT u1 present 
#MEASUREMENTVAR = 8, 1, -, PPT u2 present 
#MEASUREMENTVAR = 9, 0, -, PPT u3 present 
#MEASUREMENTVAR = 10, 1, -, inclination measurement present 
#MEASUREMENTVAR = 11, 1, -, use of back-flow compensator  
(Nov 2000 C) 
#MEASUREMENTVAR = 12, 0, -, electronic cone penetration test 
(Nov 2000 N) 
#MEASUREMENTVAR = 13, 1.52, m, pre-excavated depth 
(Nov 2000 N) 
#MEASUREMENTVAR = 14, 0.10, m, groundwater level with respect to datum in ZID 
(Nov 2000 N) 
#MEASUREMENTVAR = 16, 57.52, m, End depth of probe 
#MEASUREMENTVAR = 17, 6, -, Stop criteria: obstacle 
#MEASUREMENTVAR = 20, 0.000, MPa, zero measurement before penetration test 
#MEASUREMENTVAR = 21, -0.001, MPa, zero measurement after penetration test,  
#MEASUREMENTVAR = 22, 0.0000, MPa, zero measurement friction before penetration 

test 
#MEASUREMENTVAR = 23, 0.0002, MPa, zero measurement friction after penetration 

test 
#MEASUREMENTVAR = 26, 0.0000, MPa, zero measurement PPT u2  before penetr. test 
#MEASUREMENTVAR = 27, 0.0003, MPa, zero measurement PPT u2  after penetr. test 
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#MEASUREMENTVAR = 32, 0.01, gr, zero measurement inclination NS before penetr. 
test 

#MEASUREMENTVAR = 33, -.02, gr, zero measurement inclination NS after penetr. test 
#MEASUREMENTVAR = 34, 0.01, gr, zero measurement inclination EW  before penetr. 

test 
#MEASUREMENTVAR = 35, 0.03, gr, zero measurement inclination EW after penetr. test 
(April 2004 C) 
#REPORTCODE = GEF-CPT-Report, 1,1,0, - 
#PROJECTID = CT, 380731, 02 
#RECORDSEPARATOR = ! 
#REPORTDATAFORMAT = F7.2 F7.3 F8.4 F8.4 F5.1 F5.1 F9.2 F9.3 F6.2 I6 F7.2 
#SPECIMENVAR = 1, 0.00, m, 15 = pure peat 
#SPECIMENVAR = 2, 0.40, m, 10 = sand clayish 
#SPECIMENVAR = 3, 0.80, m, 20 = gravel silty 
#SPECIMENVAR = 4, 1.30, m, 15 = pure peat  
#STARTDATE = 1998, 02, 01 
#STARTTIME = 10, 03, 59 
#STRUCTURETEXT = COLUMNINFO, column number in data block, unit, quantity, 

quantity-number 
#STRUCTURETYPE = COLUMNINFO, integer, string, string, integer 
#TESTID = C2-366 
(Nov 2000 C) 
#XYID = 31000, 123456.543, 110011.22, 0.001, 0.01 
(Nov 2000 C) 
#ZID = 31000, 2.01, 0.01 
#EOH  = 
(Nov 2000 C) (all data are corrected) 
1.52:0.382:0.0127:-0.0021:0.2:0.4:1.52:0.384:3.32:1:-0.02:! 
1.54:0.382:0.0137:0.0045:0.2:0.4:1.54:0.379:3.59:2:-0.01:! 
1.56:0.375:0.0151:0.0126:0.3:0.3:1.56:0.366:4.03:3:0.00:! 
1.58:0.375:0.0164:0.0191:0.2:0.4:1.58:0.361:4.37:4:0.00:example commentary text 1! 
1.60:0.414:0.0169:0.0051:0.3:0.4:1.59:0.410:4.08:5:-0.01:! 
......... 
57.54:21.648:0.3706:0.0407:8.6:5.2:57.39:21.619:1.71:3987:-0.53:! 
57.56:18.683:0.369:0.1252:8.6:5.1:57.41:18.593:1.98:3988:-0.45:! 
57.58:16.735:0.3643:0.2507:8.6:5.2:57.43:16.554:2.18:3989:-0.33:! 
57.60:15.499:0.3722:0.4095:8.5:5.2:57.45:15.204:2.40:3990:-0.17:example commentary text 2! 
57.62:16.239:0.386:0.5281:8.5:5.2:57.47:15.859:2.38:4438:-0.05:! 
57.64:18.495:0.3914:0.5549:8.5:5.1:57.48:18.095:2.12:4440:-0.02:! 
 
 
 
 
 
 
 



33 

(Nov 2000 I) Sections 5.1, 5.2 and 5.3 are added. 

5 HINTS AND TIPS 

5.1 Special characters in GEF 
In GEF the hash (#), the equals sign (=) and the comma (,) have a special meaning. # signals the start 
of a new code word, = signals the end of a code word while the comma separates two fields of 
information. Therefore it is not possible to use these signs as part of a field without special 
precautions. In order to use these characters, they have to be taken literal. The same method as in the 
Unix operating system is applied: escaping special characters with a backslash. This makes the 
backslash a special character as well. 
 
Example. In reporttext 201 the following text has to be stored: "Height = 15 m, lot #3". The 
unambigual way to store this info is: 
 
#REPORTTEXT = 201, Height \= 15 m\, lot \#3, - 
 
The general GEF software stores this information as: "Height \= 15 m\, lot \#3" (without the double 
quotes). The function to retrieve the text (in this case: get_reporttext_tekst) returns the text exactly as 
it was stored: Height \= 15 m\, lot \#3. The CUR committee has decided that it is up to the user to add 
and remove these backslahses, when he applies e.g. reporttexts in a graphical representation of a CPT.  
 

5.2 Pre-excavation 
There are several reasons to perform a CPT. One of them is characterisation of the subsoil. If by any 
means cone penetration is not possible within the first few meters below ground level, e.g. due to 
cobbles, bricks etc., such a layer is removed. CPT data on this layer is not available. The CUR 
committee strongly advises to characterise the layers, which are not covered by the actual CPT. The 
code words Specimenvar and Specimentext are suited for the description or characterisation of soil 
samples.  
 
Example. A layer of 0.75 meter is pre-excavated due to stray bricks. The type of soil is reported by: 
 
#measurementvar = 13, 0.75, m, pre-excavated depth  
#specimenvar = 1, 0.25, m, peat with plant roots and bricks 
#specimenvar = 2, 0.4, m, clay very silty and bricks 
#specimenvar =3, 0.75, m, silt moderate sandy and bricks 
 
The levels reported in the value field of the specimenvar's are the lower boundary of the layer. Their 
values are expressed as a length; its origin is the fixed horizontal level, as reported in measurementtext 
9.  
 

5.3 Coordinate systems and their units 
 
The code words XYID and ZID provide information about the location of a test. The first field of 
these code words state the type and nature of the coordinate system. Each coordinate system uses 
units. ZID referring to the NAP datum is expressed in meters, XYID referring to RD (31000) is 
expressed in meters, whereas geographical coordinates (00001) are expressed in degrees.  
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When local coordinates (00000) are being used, their units are unknown. The CUR committee advises 
to report the units of any local coordinate system (meters, feet, fathoms or furlongs) in the appropriate 
measurementtexts 7 and 8.  
 
Example. A CPT is performed 15 m perpendicular to the fence of an airport. The elevation of the 
ground level is 2.54 m lower than the top of the foundation of the adjacent 380 kV pole. The code 
words in the header should read: 
 
#MEASUREMENTTEXT = 7, measured perpendicular to the fence of the airport in meters 
#MEASUREMENTTEXT = 8, measured with respect to the top of the foundation of the 

adjacent 380 kV pole in meters 
#XYID = 0, 15 
#ZID = 0, -2.54 
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6 WHAT IS VERIFIED BY GEF VERIFICATION 
 
When the program GEF Verification is started an empty screen is shown. The program is operated by 
using the menu options or optionally by using the toolbar of which the buttons represent some of the 
common functions in the menus. 
 
File→Open 
 
This opens a GEF-file. A file selection box allows the user to browse directories for GEF-files. By 
default only files with the extension .GEF are shown, but this can be changed in the ‘show files of 
type’ box. To select a batch (=multiple files) the shift and control buttons must be used in combination 
with the mouse. After opening the verification is automatically performed and the verification log is 
shown on the screen. 
 
File→Close 
 
This closes GEF-files that have been opened. The screen will appear empty again. 
 
File→Save logfile as… 
 
The verification log can be saved in text format as a file with a filename that can be chosen by the 
user. Use the .TXT extension if you would like the file to open with Notepad. 
 
File→Convert NENGEO Files… 
 
This converts NENGEO-files to GEF-files. The file open box automatically lists files with a .SON 
extension. As in File:Open it is possible to change this extension and in the same way it is possible to 
select multiple NENGEO-files. After selection the files are automatically converted to GEF-files and 
saved in the same directory with the same name but with the extension .GEF instead of .SON. It is not 
possible to convert NENGEO files which contain multiple sessions. If a corrupt NENGEO file or a 
NENGEO file with multiple sessions is encountered the user is informed that the file can not be 
converted. 
 
File→Exit 
 
This exits GEF Verification 
 
View→Verification 
 
The screen can only display one of the three views at a time: 
Verification, File or Curve. 
The verification view shows the log file with the verification results. 
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View→File 
 
This option can only be selected if a single file is opened. The content of the GEF-file is shown in text 
format. 
 
View→Curve 
 
This option can only be selected if a single file is opened and the errors found in the verification are 
not related to errors in the data block. It shows graphs of the 4 most important quantities (if present) in 
a GEF-CPT-Report file as a function of depth. 
 
View→Toolbar 
 
Toggles between showing the toolbar or not. 
 
View→Statusbar 
 
Toggles between showing the statusbar or not. 
 
Options 
 
Toggle between: 
 
- Only verifying the header of the GEF-file 
- Verifying both the header and the data block of the GEF-file. 
 
About 
 
Displays the about box 
 
 

6.1 Verification of GEF 
 
A CPT-file in GEF-CPT-Report format consists of a header and a data block section.  
GEF Verification verifies the following: 
 
#GEFID in first line 
 
If the first line does not contain the #GEFID code word no further checks will be done. The file is 
considered not to be a GEF-file 
 
Code word identification 
 
The header sequentially searches for code words which must always start with a ‘#’-sign. The end of 
the code word is indicated by the ‘=’-sign. Between the code word and the ‘=’-sign, space is allowed. 
An error is reported if after 1024 characters a ‘#’-sign has not been found. 
An error is reported if a ‘#’ is found, but after 1024 characters a‘=’-sign misses. 
An error is reported if a code word is unknown. 
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Checking the number of parameters 
 
After the ‘=’-sign a code word has a certain number of parameters separated by comma’s. Some 
parameters are obligatory, others are optional. An error is reported if the number of parameters is 
smaller than the minimum number of obligatory parameters or larger than the maximum number of 
parameters possible for the specific code word. 
 
Type-checking the parameters 
 
An error is reported if a parameter has the wrong type. For example if a certain parameter is a 
string(text), but an integer(number) is expected, this will be reported 
 
Repeated code words 
 
Some code words can only be used once. Others can be used more often, but only once, in 
combination with a certain parameter (for example with a certain column). GEF Verification reports 
an error if code words are encountered which have already been used or have already been used in 
combination with a certain parameter. 
 
Warning for wrong version 
 
GEF Verification 1.0 verifies GEF-CPT-Report 1.0.0. If a GEF-file has a different version the 
software reports a warning. 
 
 
Obligatory code words in GEF-CPT-Report  
 
The following code words are obligatory code words in GEF-CPT-Report only: 
 
- #GEFID 
- #COLUMN 
- #COLUMNINFO for each column 
- #COMPANYID 
- #FILEDATE 
- #FILEOWNER 
- #LASTSCAN 
- #PROCEDURECODE 
- (Nov 2000 N) either #PROCEDURECODE and or #REPORTCODE 
- #PROJECTID 
- #TESTID 
- (Nov 2000 N) #ZID 
- (Nov 2000 N) #MEASUREMENTTEXT = 9, etc 
- #EOH 
 
(April 2004 N) 
• In version 1,0,0 the keyword #PROCEDURECODE = GEF-CPT-Report, 1, 0, 0 is mandatory. 
• In versions 1,1,0 and up, either #REPORTCODE = GEF-CPT-Report, 1, 1, 0 (or 

#PROCEDURECODE = GEF-CPT-Report, 1, 1, 0) is mandatory. The use of Reportcode is 
preferred. In the exceptional case that both Reportcode and Procedurecode are present, the 
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contents of procedurecode is neglected when determining the type and version of a GEF-CPT-
Report file.  

 
If any of these code words was not found after searching the entire file, an error is reported. 
If the #COLUMN or #LASTSCAN code word are, missing GEF Verification does not have enough 
information to start reading the data block. Consequently, the curve cannot be displayed. 
 
Check the parameters of #COLUMNINFO 
 
The code word #COLUMNINFO assigns a certain parameter like cone resistance, friction ratio, pore 
water pressure, corrected depth, slope etc. to a specific column number in the GEF-file. Each 
parameter has its own unambiguous identification number. 
An error is reported if a parameter is assigned to two different columns, since this would create an 
ambiguous situation when locating the correct column for a specific parameter. 
An error is reported if parameter 1 ‘Length’ or parameter 2 ‘Cone Resistance’ have not been assigned 
to a column. The definition of the GEF-CPT-Report file format says these parameters must be present 
in the file. 
 
Check data block 
 
In the header it is optionally possible to specify a column separator and a record separator. It is also 
possible to allow the use of extra text in the data block if the #COLUMNTEXT code word is used. 
GEF Verification reads the data block and stops if an error occurs. If this error occurs, the type of 
error is reported. If an error occurs when reading the data block, it is not possible to view any curves. 
 
Minimum and maximum values of the columns 
 
If the data block has been read, it is possible to calculate the minimum and maximum value of each 
column. These values can be compared to the minimum and maximum values stated by the (optional) 
code word #COLUMNMINMAX in the headerblock and tested for. If the comparison gives different 
values, an error is reported. 
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APPENDIX 1: 
 
GLOSSARY FOR STANDARDISING DIGITAL DATA OF CONE  
PENETRATION TESTS  
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The table below briefly describes all the concepts used. 
 
Concept Description 
[integer] integer number, no decimals allowed 
[character] a number, character or punctuation mark 
[number] integer number, no decimals allowed 
[text] numbers, characters, punctuation marks 
apparatus probe apparatus and data acquisition system to perform cone 

penetration test (pushing, measuring, registering and storing) 
ASCII American Standard Code Information Interchange 
back-flow compensator facility to compensate the probe length for upwards movements of 

the probe housing 
calculated columns column data stored in GEF and calculated externally, based on 

known calculation formulae where appropriate 
calculation formula formula for calculating new quantities, such as friction figure is the 

quotient of skin friction and cone resistance, using (different) 
measurement data possibly supplemented with extra parameters 

calculation procedures software component which converts measured data into calculated 
data 

character single readable character 
class of the penetration one of the three NEN 5140-defined (quality) classes test in 

accordance with NEN 5140 
code words words defined in GEF, also described as a string name 
computer system such as DOS, Unix, Apple 
cone penetration test measurement of the mechanical soil resistance using a cone over 

the specified depth of traject 
Cone Penetration Test Report 
format 

CPT-Report, using GEF 

cone resistance qc  the resistance needed during the penetration test to move the cone 
tip 

cone tip part of the penetration cone which defines the tip resistance qc 
column collection of data defined using the same fixed position on a line of 

each individual registration with the depth/time 
column information definition of the content and description of a data column in the file 
column number the number of a column 
compulsory measurement 
values 

length and cone resistance (minimum content) 

coordinate system definition used for x,y, and sometimes z coordinates, such as the 
Geographical coordinate system: longitude and latitude 

corrected cone resistance qt the cone resistance corrected for the difference in pore water 
pressure below and above the cone tip 

corrected depth depth of the penetration cone, measured beneath a fixed horizontal 
reference level, taking into account the deviation of the casing with 
respect to the vertical 

country code code of the country for defining the reference height level 
CR/LF control characters which indicate the end of a line 

 
data block part of the file where the measured and calculated data are stored in 
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Concept Description 
accordance with the definition specified by the header block 

data, calculated data calculated using the known calculation formulae 
data descriptive data describing its own contents 
data, fixed static data 
data format definition of the data storage 
date of penetration test day on which a CPT was carried out, given as dd-mm-yyyy 
(Nov 2000 C) yyyy,mm,dd description of the year with four characters, the month with two 

characters, the day of the month with two characters  
default value value which applies if no other value is input 
(Nov 2000 I) depth length of the projection on a vertical line, of the path of the 

penetration.  
depth of first observation depth below the selected horizontal (fixed) reference level used to 

register the data which can be considered as in-situ measurements 
(for example pre-test, -excavating or -drilling) 

digital in symbols, coded, used to store documents via computers 
dimension see unit 
dissipation test specifying the change in pore water pressure in the penetration cone 

in the time at a constant depth after the penetration cone is 
stationary 

effective vertical soil σ’v;0 stress calculated effective vertical granular stress, being the total wet 
weight per surface area of the above-lying soil minus the prevailing 
pore water pressure 

(Nov 2000 I) elevation position of a point with respect to a datum. 
executing company name of company performing the cone penetration test 
excess pore pressure ratio DPPR ratio number between measured excess pressure and the cone 

resistance qc :DPPR = (u - uo)/qc 
figure decimal number 
file digital file 
file descriptive definition of a digital file including its definitions used for storage, 

such as definition of the foundation for the description (GEF 
version number, for example) 

file tracing possibility to trace who created the file 
final depth depth at which the cone penetration test stops 
fixed position defined place in GEF 
format the only word which in principle cannot be used in this project, in 

combination with other words intended as (agreed) structure of... 
friction figure Rf quotient of local friction and cone resistance 
GEF definition definition of the GEF format in written form 
Geotechnical Exchange Format agreed name of the exchange format 
inclination (resultant not 
direction-oriented) 

deviation from the vertical in degrees 

inclination EW deviation from the vertical in EW direction in degrees 
inclination NS deviation from the vertical in NS direction in degrees 
groundwater level level of the groundwater beneath the ground level 
header block part of the file which describes the stored data  
height of the selected horizontal 
reference level (= usually 

height 
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Concept Description 
ground level) beneath fixed 
reference level 
identification number of 
penetration test 

number of the cone penetration test for internal processing 

in-situ, initial water pressure uo prevailing static pore pressure in the soil 
interruptions temporary interruption of one or more components of the 

penetration process 
keywords not used, see code words 
scan a collection of measurement values for one depth 
maximum value maximum registered measurement value of a parameter during a 

cone penetration test 
measured cone resistance qc the resistance necessary to move the cone tip downwards during the 

cone penetration test 
measurement elements the part of the apparatus used to register the measurement values 

(e.g. the stretching gauge for the cone tip and not the probe rod) 
measurement data collection of measurement values 
measurement procedures pre-written series of actions to collect measurement data 
measurement scan in principle not used (see measurement data) 
measurement texts in principle not used (description uses code words, column 

information and columns) 
measurement variables in principle not used (description uses code words, column 

information and columns) 
measurement value a measured value 
measurement the collection of measured values (such as cone resistance) 
minimum values minimum registered measurement value during a cone penetration 

test 
mm description of the month of the year with two characters 
NEN 3680 Dutch Standard for performing cone penetration tests (only valid 

for mechanical penetration tests) 
NEN 5140 Dutch Standard for performing electronic cone penetration tests 
net cone resistance qn cone resistance corrected for pore pressure and the effective vertical 

soil stress 
net surface area quotient ratio of the gross surface area to the net surface area above the cone 

tip in relation to the action of pore pressure 
number an integer number 
original information sources information about who created the file 
order number order number defined by the user processing the file (this can 

therefore change during the life-time of the file) 
parameter in principle not used, see quantity 
remarks circumstances worth mentioning during measurement which may 

influence the interpretation of the results, such as a power failure 
point of time when penetration 
test starts 

hour, minute, seconds since start of the cone penetration test or 
recording the zero measurements 

pore pressure u1 measured pore pressure in the cone tip 
pore pressure u2 measured pore pressure directly behind the cone tip 
pore pressure u3 measured pore pressure directly above the friction casing 
pore pressure ratio Bq ratio number between measured excess pore pressure and the cone 
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Concept Description 
resistance qc corrected for the total soil pressure Bq = (u-uo)/(qc-σvo) 

print format format of printed values 
penetration cone instrument used to measure the mechanical soil resistance 
penetration data data collected using the penetration cone 
penetration length distance traversed by the penetration cone in the soil 
penetration location location of the starting point of the cone penetration test 
penetration report report of the measurement results 
procedure descriptive providing a description of the procedure for the evaluation of data 
procedures see measurement procedures 
processing registration/display method (in particular, interruptions) 
project information description of project information which is relevant to file 

management and reporting 
quantities name of the data in one column 
quantity number number representing the type of data in one column 
reference level fixed level, for example NAP but not curbstone 
release version of the GEF definition 
release number number of the version of the GEF definition 
report form of data transfer to the client 
results in principle not used, see calculated data 
results, deduced in principle not used, see calculated data. The distinction between 

deduced and ‘ordinary’ results is formed by defining the 
relationship between measured and calculated data; empirical 
formulae are used for the deduced results. 

separating character defined character which indicates the division between two 
columns 

friction  friction along the friction casing 
friction casing cylindrical part of the probe cone, directly above the cone tip, 

which measures the friction along the cone casing 
standard definition agreed and confirmed by standardisation institute for 

actions, qualitative or procedural 
stop criteria defined type of exceeding of one or more of the requirements of the 

cone penetration test 
structure defined structure 
structure information definition of the structure 
text readable text of 256 characters maximum, without commas or #s 
text field string 
time time passed since the start of the cone penetration test or recording 

the zero measurements 
total vertical soil pressure, σ’v0 calculated total wet weight per unit area of the soil above 
type of penetration test cone (resistance) possibly supplemented by local friction  
unit for example MPa, m or % 
unusual circumstances circumstances worth mentioning during the cone penetration test 

which may influence the interpretation of the result, such as an 
exceptional groundwater level 

weight per unit volume, γ weight of wet soil in weight per unit volume 
water depth depth of the bottom of the water with respect to the water surface 
PPT filter (u1, u2, or u3) filter that only allows water to pass (or any other liquid) and 
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Concept Description 
protects the pore pressure transducer against contact with soil grains 

X and Y coordinates horizontal coordinates 
yyyy description of the year using four characters 
Z coordinate vertical coordinate 
zero measurement read-out of the constant value of a measuring instrument, without 

the instrument being affected 
zero drift change in the zero value during or after a test 
zero values measured value during the zero measurement 
 
 
 


